
Microsoft Word 2007 
 

I. Mengenal Microsoft Word 
Microsoft Word (MS Word) merupakan program untuk mengolah kata. Program 
ini bisa digunakan untuk menulis dokumen misalnya karya tulis, skripsi, novel, 
dan sebagainya. Selain menulis dokumen, MS Word juga dapat digunakan untuk 
bekerja dengan tabel, menulis teks dengan kreasi, menyisipkan gambar, maupun 
yang lainnya. 
 
Secara default tampilan area kerja program MS Word 2007 terdiri atas Title Bar, 
Office Button, Quick Access Toolbar, Menu Bar, Ribbon, Ruler, Status Bar, dan 
View Toolbar. Tampilan area kerja dapat dilihat pada Gambar 1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Title Bar berisi nama file yang sedang dikerjakan, serta tombol menampilkan, 
atau menyembunyikan jendela program, dan menutup program, yaitu tombol 
Minimize, Maximize/Restore, dan Close. 
 
Office Button berisi perintah-perintah yang berkaitan dengan dokumen seperti 
membuat dokumen baru (New), membuka dokumen (Open), menyimpan 
dokumen (Save), mencetak dokumen (Print), dan sebagainya (Gambar 2). 
 
 

Title Bar

Menu Bar
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Gambar 1. Tampilan area kerja MS Word 
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Quick Access Toolbar berisi tombol-tombol yang berfungsi sebagai alternatif 
penggunaan perintah yang sering digunakan. Sebagai contoh, tool Open 
merupakan shortcut dari  Office Button>Open, atau tool Save merupakan 
shortcut dari Office Button>Save. 

 
Menu Bar berisi serangkaian perintah yang didalamnya terdapat sub-sub perintah 
sesuai kategorinya. Sebagai contoh, pada menu Home terdapat submenu 
Clipboard, Font, Paragraph, Styles, dan Editing yang didalamnya berisi 
perintah-perintah sesuai kategorinya. 

 
 Ribbon berisi perintah-perintah khusus yang merupakan submenu dari Menu Bar. 
 

Ruler merupakan kotak pengukuran yang diletakkan secara horizontal, yaitu di 
atas dokumen, dan secara vertikal, yaitu di sebelah kiri dokumen. Ruler berfungsi 
untuk mempermudah melakukan pengaturan letak halaman. 

 
Status Bar adalah baris horizontal yang menampilkan informasi jendela dokumen 
yang sedang ditampilkan, antara lain (Gambar 3): 
 
 
 
 

 
• Page: menampilkan informasi halaman (Gambar 3.1). 

 
 
 
 

Gambar 2. Menu-menu dalam Office Button 

Gambar 3. Status Bar 

Nitro PDF Professional
Page 2/17

Nitro PDF Professional
Page 2/17

Modul Microsoft Word 2007 – Program Keahlian semester gasal 2013/2014                                     2 
Page 2 / 17

http://www.artspdf.com/
http://www.nitropdf.com/
http://www.artspdf.com/
http://www.nitropdf.com/


 
   
 
 
 
 
 
 
 
 
 
 
 
 

• Words: Menampilkan jumlah halaman, kata, huruf (tanpa spasi), huruf 
(dengan spasi), paragraf, dan baris (Gambar 3.2). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
View Toolbar berisi pengaturan jenis tampilan dokumen, antara lain: 

• Print Layout: memberikan tampilan sesuai hasil yang akan diterima pada 
saat dicetak (default). 

• Full Screen Reading: memberikan tampilan halaman penuh. 
• Web Layout: memberikan tampilan sesuai hasil yang ditampilkan di 

dalam jendela browser. 
• Outline: memberikan tampilan sesuai heading di dalam dokumen dan 

tingkatan di dalam struktur dokumen. 
• Draft: memberikan tampilan yang berkelanjutan (menggabungkan seluruh 

halaman seperti dalam satu gulungan). Tiap halaman dipisahkan oleh garis 
titik-titik. 

 

II. Membuat, menyimpan, menutup, dan membuka dokumen 
 

Untuk membuat dokumen baru, dapat dilakukan dengan cara berikut: 

Gambar 3.1. Page Search 

Gambar 3.2. Word Count
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1. Klik Office Button>New sehingga muncul jendela baru yang menampilkan 
bagian New Document. 

2. Setelah itu pilihlah Blank Document untuk membuat dokumen. (Dapat juga 
memilih salah satu dokumen template untuk membuat dokumen baru 
berdasarkan template yang telah disediakan.) 

Di dalam Quick Access Toolbar juga terdapat tombol New (Gambar 4) yang 
berfungsi untuk membuat dokumen baru tanpa melalui jendela baru. 
 
 
 
 
 
 
 
 
 
 
Sebelum memulai dokumen, sebaiknya atur properti terlebih dahulu. Pengaturan 
properti mempengaruhi hasil cetakan. Pengaturan properti dapat dilakukan 
dengan mengklik menu Page Layout. Kemudian pada ribbon Page Setup, klik 
ikon kecil pada pojok kanan bawah (Gambar 5.1.) sehingga muncul kotak dialog 
Page Setup (Gambar 5.2). Kotak dialog ini terdiri dari tiga bagian, yaitu 
Margins, Paper, dan Layout. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Klik disini

Gambar 4. Tombol New di Quick Access Toolbar 

Gambar 5.1 Ribbon Page Setup 

Gambar 5.2. Kotak dialog Page Setup 
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• Margins: untuk menentukan batas atas (Top), kiri (Left), kanan (Right), 
dan bawah (Bottom) dokumen, dan ada juga orientasi kertas. Gambar 6 
menunjukan margin halaman. 

• Paper Size: untuk menentukan ukuran kertas yang akan digunakan 
dengan memilih opsinya pada menu drop-down. Jika menginginkan 
ukuran kertas sendiri, dapat diisi nilainya secara langsung pada kotak 
Width dan Height. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Untuk menyimpan dokumen baru, secara default nama dokumen yang dibuat akan 
berurutan, yaitu Document 1, Document 2, Document 3, dan seterusnya. Cara 
untuk menyimpan dokumen adalah sebagai berikut: 
1. Klik Office Button>Save atau Office Button>Save As sehingga muncul 

kotak dialog Save As (Gambar 8). 
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Gambar 6. Margin halaman 

Gambar 8. Kotak dialog Save As 
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2. Di dalam kotak dialog tersebut, lakukan pengaturan sebagai berikut: 
• Save in: tentukan lokasi folder tempat dokumen akan disimpan. 
• File name: ketikkan nama untuk identifikasi dokumen. 
• Save as type: type dokumen, gunakan default yang diberikan, yaitu 

Word Document. 
• Klik tab Save untuk menyimpan dokumen tersebut. 

Untuk menyimpan dokumen lama yang telah diedit, klik Office Button>Save. 
Apabila dokumen tersebut hendak disimpan dengan nama yang berbeda, klik 
Office Button>Save As sehingga caranya sama seperti menyimpan dokumen 
baru. Apabila dalam menyimpan dokumen, nama yang digunakan sama dengan 
nama yang sudah ada di dalam folder, maka kotak konfirmasi seperti pada 
Gambar 9 akan muncul. 
 
 
 
 
 
 
 
 
 
 
 
 
• Replace exiting file: menimpa file yang sudah ada dengan dokuman baru. 
• Save change with a different name: menyimpan dokumen baru denga nama 

lain. 
• Merge into exiting file: menggabungkan perubahan yang dilakukan kedalam 

file yang sudah ada. 
 

Setelah selesai mengedit dokumen dan memastikan sudah menyimpannya, ada 
beberapa cara untuk menutup dokumen, yaitu: 

• Klik Office Button>Close. 
• Klik tombol Close Window           yang terdapat dalam Title Bar. 

 
Dokumen yang telah disimpan dapat dibuka dengan salah satu cara berikut: 

• Klik Office Button>Open. 
• Klik tombol Open        yang terdapat di dalam Quick Access Toolbar. 
Sehingga muncul kotak dialog Open (Gambar 10), kemudian pilih file 
dokumen yang hendak dibuka. 

 
 
 
 
 
 

Gambar 9. Kotak konfirmasi penyimpanan. 
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III. Menuliskan dan memformat teks dan paragraf 
 

Pengetikan teks dimulai dari titik sisip (titik iterasi). Titik sisip dapat dilihat dari 
garis hitam yang berkedip di dalam halaman dokumen. Dalam mengetikkan teks, 
penekanan tombol Enter pada keyboard akan membuat paragraf baru. Untuk 
membuat hasil yang maksimal, maka diperlukan pemformatan karakter, seperti 
menentukan jenis huruf, tipe huruf, ukuran huruf, dan lainnya. Pemformatan 
karakter dapat diterapkan sebelum ataupun sesudah pengetikan. Klik menu 
Home, kemudian pada ribbon Font klik ikon di pojok kanan bawah (Gambar 
11.1) untuk melakukan pemformatan sehingga muncul kotak dialog Font seperti 
pada Gambar 11.2. 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

Gambar 11.1. Ribbon Font 

Gambar 10. Kotak dialog Open 

Klik disini 

Gambar 11.2. kotak dialog Font 
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• Font: untuk menentukan jenis huruf yang digunakan. 
•  Font Style: menentukan tipe huruf, yaitu Regular (biasa), Italic (miring), 
• Bold (tebal), dan Bold Italic (tebal dan miring). 
•  Size: menentukan ukuran huruf. 
•  Font Color: menentukan warna huruf. 
•  Effects: untuk membuat efek-efek yang akan diterapkan pada teks. 
•  Preview: menampilkan contoh hasil pengaturan format teks. 

 
Tabel di bawah ini memperlihatkan contoh-contoh hasil pemformatan teks dan 
penggunaan efek di dalam teks. 

 
Format Karakter Hasil Format Karakter 

Regular Ini contoh teks dengan efek 
Bold Ini contoh teks dengan efek 
Italic Ini contoh teks dengan efek 
Bold Italic Ini contoh teks dengan efek 
Underline Ini contoh teks dengan efek 
Bold-Italic-Underline Ini contoh teks dengan efek 
Strikethrough Ini contoh teks dengan efek 
Double Strikethrough Ini contoh teks dengan efek 
Superscript Ini contoh teks dengan efek

Subscript Ini contoh teks dengan efek
Shadow IInnii ccoonnttoohh tteekkss ddeennggaann eeffeekk 
Outline 
Emboss IIInnniii  cccooonnntttooohhh ttteeekkksss dddeeennngggaaannn eeefffeeekkk 
Engrave IIInnniii cccooonnntttooohhh ttteeekkksss dddeeennngggaaannn eeefffeeekkk 
Small caps INI CONTOH TEKS DENGAN EFEK 
All caps INI CONTOH TEKS DENGAN EFEK 
Hidden (tidak terlihat) 

 
 

Selain pemformatan huruf, juga ada pengaturan paragraf. Perataan paragraf ada 
empat macam, yaitu rata kiri (Align Left)       , rata tengah (Center)     , rata 
kanan (Align Right)       , dan rata kiri kanan (Justified)       . 
Contoh penggunaan perataan paragraf: 
• Rata kiri: 

Microsoft Word (MS Word) merupakan program untuk mengolah kata. 
Program ini bisa digunakan untuk menulis dokumen misalnya karya tulis, 
skripsi, novel, dan sebagainya. 
 

• Rata tengah: 
Microsoft Word (MS Word) merupakan program untuk mengolah kata. 

Program ini bisa digunakan untuk menulis dokumen misalnya karya tulis, 
skripsi, novel, dan sebagainya. 
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• Rata kanan: 
Microsoft Word (MS Word) merupakan program untuk mengolah kata. 

Program ini bisa digunakan untuk menulis dokumen misalnya karya tulis, 
skripsi, novel, dan sebagainya. 

 
• Rata kiri kanan (justified): 

Microsoft Word (MS Word) merupakan program untuk mengolah kata. 
Program ini bisa digunakan untuk menulis dokumen misalnya karya tulis, 
skripsi, novel, dan sebagainya. 
 

Pengaturan spasi baris adalah pengaturan jarak antarbaris di dalam paragraf. 
Pengaturan ini dapat dilakukan dengan tombol Line Spacing      . Contoh 
penggunaan Line Spacing. 
• Pengaturan spasi baris dengan nilai Single 
Microsoft Word (MS Word) merupakan program untuk mengolah kata. Program 
ini bisa digunakan untuk menulis dokumen misalnya karya tulis, skripsi, novel, 
dan sebagainya. 
• Pengaturan spasi baris dengan nilai Double 
Microsoft Word (MS Word) merupakan program untuk mengolah kata. Program 

ini bisa digunakan untuk menulis dokumen misalnya karya tulis, skripsi, novel, 

dan sebagainya. 

 
Menyisipkan tabulasi juga sering digunakan dalam membuat dokumen. Contoh 
penggunaannya dapat dilihat pada Gambar 12. 

 
 
 
 
 
 
 
 
 

 
Cara paling mudah dalam menggunakan tabulasi adalah dengan memposisikan 
pointer pada Ruler kemudian klik pointer sehingga muncul simbol tabulasi. 
Untuk menghapus tabulasi, seret simbol tabulasi keluar Ruler. Ada lima 
alignment yang dapat dipilih, yaitu Left         , Center       , Right      , Decimal 
dan Bar       . 
 
 
 
 

Gambar 12. Penggunaan tabulasi di dalam dokumen 
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Mengedit text meliputi menghapus, memilih, menggandakan, dan lain sebagainya. 
• Memilih karakter, kata, baris, dan paragraf 

Karakter yang terpilih akan ditandai dengan kotak hitam yang menutupinya 
dan warna karakter akan berubah terang. Untuk memilih karakter yang 
berurutan, posisikan pointer di belakang karakter pertama, tekan mouse, 
kemudian seret ke arah karakter-karakter yang dipilih. Untuk kata-kata yang 
tidak berurutan, tekan tombol Control pada keyboard sebelum berpindah ke 
kata yang berikutnya. Untuk memilih satu baris, posisikan pointer di sebelah 
kiri baris sehingga pointer berubah menjadi tanda anak panah, kemudian klik 
hingga baris tersebut terplih. Untuk memilih satu paragraf, posisikan pointer 
di atas sembarang teks di dalam paragraf, kemudian klik tiga kali maka 
seluruh paragraf akan terpilih. Dan untuk memilih seluruh karakter, pilih tab home 
kemudian pada ribbon pilih select > select all. 

• Menghapus karakter 
Penghapusan karakter dapat menggunakan tombol Del dan Backspace pada 
keyboard. Perbedaan diantara keduanya adalah: 

o Apabila titik sisip berada di belakang karakter yang akan dihapus, 
gunakan tombol Del pada keyboard. 

o Apabila titik sisip berada di depan karakter yang dihapus, tekan tombol 
Backspace pada keyboard. 

• Menggunakan perintah Copy, Cut, dan Paste 
Perintah Copy dan paste mempunyai kaitan. Perintah Copy digunakan untuk 
menggandakan karakter yang terpilih untuk kemudian menempatkannya pada posisi 
lain, perintah Paste adalah untuk menempatkan hasil pengoperasian perintah tersebut 
ke tempat yang baru. Perintah Cut digunakan untuk memotong karakter yang 
terpilih untuk kemudian dipindahkan. Perintah Cut juga memerlukan perintah Paste 
untuk menempatkan hasil ke tempat yang baru. Bedanya dengan perintah Copy 
adalah perintah Cut akan menghapus karakter yang berada pada posisi aslinya, 
sedangkan perintah Copy tidak menghapus karakter pada posisi asli. Perintah Copy, 
Cut, dan Paste juga berlaku antar dokumen. 
 

• Menggunakan perintah Undo dan Redo 
Perintah Undo digunakan untuk mengembalikan aksi yang telah dilakukan ke aksi 

sebelumnya. Sedangkan Redo adalah sebaliknya 
 

V. Menggunakan penomoran dan penandaan 

Seringkali di dalam dokumen dijumpai penulisan teks dengan penomoran 
(numbering) dan penandaan (bullet). Program MS Word menyediakan fasilitas 
Bullet and Numbering untuk membuat variasi teks. Dalam program word 2007 ini 
fasilitas Bullet and Numbering dapat dipilih pada Ribbon Home > Paragraph 
Perhatikan contoh penggunakan penomoran dan penandaan berikut ini : 
 
 

Contoh penandaan  : 
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Produk dari MS office antara lain : 
1) MS Word  

a) MS Excel 
i) MS Powerpoint 

 

 
 
 
 
 
 

Contoh penomoran  : 
 
 
 
 
 
 

Contoh penggunaan  :  
 
 
 
 
 
 
 

VI. Menggunakan tabel 

Pada umumnya, penyisipan tabel ke dalam dokumen berfungsi untuk mendukung 
penjelasan/uraian dokumen. Untuk membuat tabel, pilih Insert, pada ribbon pilih 
Table, kemudian pilih ukurannya. Dapat juga dengan cara, pilih Insert > Table > 
Insert Table, kemudian akan muncul dialog box seperti berikut :  
 

 
 

• Number of columns : untuk menentukan jumlah kolom, sebagai contoh isikan 2. 
• Number of rows : Untuk menentukan jumlah baris, sebagai contoh isikan 3. 
• Autofit behavior : untuk pengaturan lebar kolom. 

 
 
 

Produk dari MS office antara lain : 
• MS Word  
• MS Excel 
• MS Powerpoint 

Produk dari MS office antara lain : 
1. MS Word  
2. MS Excel 
3. MS Powerpoint 
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Text dapat langsung diketikkan pada sel dalam tabel, hasil dari contoh akan seberti 
berikut : 
 
  
  
  

 
Untuk membuat tabel menjadi bervariasi, dapat dilakukan dengan : klik tabel yang 
sudah dibuat, kemudian pada menu akan muncul dua menu tab baru, yaitu design dan 
layout. Pilih design untuk membuat tabel bervariasi.  
 

DAFTAR MATA KULIAH  

SENIN PENGANTAR  BISNIS 
PROGRAM  KEAHLIAN  1 

 
Atau dapat diatur  juga mengatur posisi text dalam kolom, mengurutkan data, dan 
sebagainya yang dapat kita lakukan dengan memilih menu tab layout. 

 
VII. Menyisipkan objek 

 
• Menyisipkan gambar 

Gambar dapat disisipkan ke dalam dokumen. Gambar yang disisipkan dapat berupa 
file gambar atau kumpulan gambar (clip art) yang telah disediakan program MS 
Word. Untuk menyisipkannya, klik tab menu Insert > Clip Art. Pada bagian Search 
for:  dapat diisi dengan kata petunjuk yang berhubungan, misalnya  animals. Maka 
akan di dapat hasil seperti berikut :  

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Untuk menyisipkan gambar yang diinginkan, tinggal klik gambar yang diinginkan. 
Berikut ini contoh hasilnya : 
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Untuk menyisipkan gambar dari file, pilih tab menu Insert > Picture sehingga 
muncul dialog box seperti berikut :  

 
 

• Menyisipkan objek AutoShape 
AutoShape adalah objek-objek dengan bentuk tertentu yang dapat disisipkan ke dalam 
dokumen. Objek-objek tersebut antara lain bentuk garis, lingkaran, persegiempat, dan 
lainnya. Untuk menyisipkannya, pilih tab menu Insert > shapes kemudian pilih 
bentuk objek  yang diinginkan. Objek – objek tersebut juga dapat disisipi text, seperti 
contoh : 

 
   

 
 
 
 

• Menyisipkan simbol 
Di dalam dokumen sering kita jumpai beberapa simbol seperti © , ® , ™ , dan lain 
sebagainya. Cara untuk menyisipkan simol – simbol tersebut, pilih tab menu Insert > 
Simbol kemudian pilih more simbols. 
 

Ini contoh 
text…. 
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• Menyisipkan diagram 
Untuk membuat diagram struktur organisasi seperti contoh di bawah, pilih tab menu 

Insert > smart art kemudian pilih organization chart . 

 
 

Untuk membuat diagram seperti contoh dibawah, pilih tab menu Insert > chart, 
kemudian ganti nilai sesuai dengan yang dikehendaki. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Untuk mengganti tipe diagram dapat dilakukan dengan klik kanan diagram, kemudian 
pilih edit, lalu pada menu pilih edit chart , kemudian pilih tipe yang 
dikehendaki. 

 
• MenyisipkanWordArt 

Teks yang dibuat dengan WordArt akan tampak lebih bervariasi. Salah satu contoh 
penggunaan WordArt adalah di bawah ini: 
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Cara menggunakannya, pilih tab menu Insert pilih wordArt, kemudian pilih tipe 
yang dikehendaki, setelah itu masukkan text yang ingin di tulis dengan wordart. 
 

• Menyisipkan nomor halaman 
Penomoran halaman dapat dilakukan secara praktis. Caranya dengan memilih tab 
menu Insert > page number, kemudian pilih letak nomor halaman sesuai dengan 
keinginan, sebagai contoh pilih Bottom of page, maka akan muncul pilihan tipe. 

 
 

• Menyisipkan Header and Footer 
Fasilitas Header and Footer digunakan untuk membuat catatan kaki, penomoran 
halaman, dan yang lainnya. Untuk masuk ke bagian ini, pilih Insert kemudian tinggal 
pilih header atau footer. selanjutnya masukkan text untuk header dan footer. Pada 
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saat mengisi text untuk header atau footer, bagian text utama akan disable, atau 
berwarna redup dan tidak dapat di edit. Untuk mengedit main text, pilih close header 
and footer pada ribbon. 
 

• Menyisipkan background atau watermark 
Jika di kehendaki dalam membuat suatu dokumen diperlukan background atau cap 
redup transparan pada hasil dokumen dapat dilakukan dengan cara, klik Page layouts 
> watermarks > custom watermarks . selanjutnya akan muncul dialog box, jika 
ingin background dengan tulisan maka pilih text watermarks kemudian atur sesuai 
keinginan. Jika ingin menggunakan background gambar pilih picture watermarks 
kemudian pilih gambar mana yang akan digunakan sebagai background. Cek juga 
pada checkbox washout untuk mendapatkan gambar background yang redup 
sehingga text pada dokumen mudah dibaca.  
 

• Borders, Shading, dan Drop Cap 
Beberapa tambahan dalam membuat dokumen tampak lebih menarik seperti contoh 
dibawah ini: 
 
 

 
MICROSOFT OFFICE 2007 

icrosoft Word (MS Word) merupakan program untuk mengolah 
kata. Program ini bisa digunakan untuk menulis dokumen 
misalnya karya tulis, skripsi, novel, dan sebagainya. Selain 

menulis dokumen, MS Word juga dapat digunakan untuk bekerja dengan 
table, menulis teks dengan kreasi, menyisipkan gambar, dll 

 
untuk bagian MICROSOFT OFFICE 2007 yang berwarna orange serta memiliki 
garis bawah, dapat dilakukan dengan memblok text tersebut, pilih  page layout > 
page borders, kemudian pilih tab Border, pilih box namun hanya pada bagian 
bawah text saja, kemudian pilih warnanya. Selanjutnya pilih tab shading kemudian 
pilih warnanya. 
Untuk huruf pertama (M) yang berukuran besar dibuat dengan cara , pilih Insert > 
Drop Cap kemudian pilih jenis yang dikehendaki. 

 
• Membuat Kolom 

Untuk membuat kolom seperti contoh di bwah ini,pilih page layouts > columns 
kemudian tentukan banyaknya kolom yang ingin dibuat. 
 

 

M 
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VIII. Membuat daftar isi 

MS Word 2007 menyediakan fasilitas yang praktis untuk membuat suatu daftar isi, 
seperti contoh dibawah ini. Caranya, pilih References > table of content kemudian 
pilih tipe sesuai dengan yang diinginkan. Jika setelah daftar isi dibuat kemudian 
terjadi update data, dimana judul dan lokasi halaman tidak sesuai, dapat diatasi 
dengan klik References > Update table > Update page number only. 
 
 

Vi. Mengedit Text ....................................................................................................................................... 10 

•  Memilih karakter, kata, baris, dan paragraf ................................................................................... 10 

•  Menghapus karakter ...................................................................................................................... 10 

•  Menggunakan perintah Copy, Cut, dan Paste ................................................................................ 10 

•  Menggunakan perintah Undo dan Redo ........................................................................................ 10 

 
 

IX.  Mencetak 

Sebelum mencetak dokumen, ada baiknya jika tampilan cetak dilihat terlebih dahulu. 
Hal ini dapat dilakukan dengan cara klik office button > Print > print Preview. Jika 
sudah sesuai, cara untuk mencetak adalah dengan klik menu File > Print sehingga 
muncul kotak dialog Print.. Atur properti atau lakukan pengaturan hasil cetakan yang 
dihendaki jika diperlukan. Klik OK. 
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